
Snimanje govornih signala korǐstenjem zvučnih kartica

U okviru laboratorijskih vježbi koristiti će se govorni signali kako bi prikazali primjenu raznih al-
goritama na stvarnim signalima. Sve će se obrade nad snimljenim govornim signalima provoditi
korǐstenjem programskog paketa MATLAB, i to izvan realnog vremena, što zapravo znači da će se
koristiti unaprijed snimljeni govorni signali.

U ovom tekstu će ukratko biti opisano kako je moguće korǐstenjem standardnih programa na PC
računalu opremljenom s zvučnom karticom snimati odnosno reproducirati govorne signale. Postupak
naveden ovdje odnosi se na PC računala koja se nalaze u studentskom laboratoriju D-138. U slučaju
korǐstenja modernijih računala s drugim zvučnim karticama koje imaju veći broj ulaznih i izlaznih
kanala te veće mogućnosti upravljanja sklopovljem sam postupak se može razlikovati, no osnovna
ideja koja će biti izložena u nastavku je primjenjiva na bilo kojoj standardnoj zvučnoj kartici.

1. Mikser za snimanje i reprodukciju

Da bi bilo moguće uspješno snimati i reproducirati govorni signal primjenom zvučne kartice s pri-
padnim zvučnicima i mikrofonom potrebno je najprije ispravno podesiti mikser koji odreduje koji se
izvor zvuka reproducira na zvučnicima, odnosno koji se izvor zvuka snima.

Program za upravljanje audio-mikserom koje se standarndno isporučuje s Microsoft R© Windows ope-
racijskim sustavom zove se Volume Control, no kako taj program ne podržava mijenjanje svih postavki
kartice koristimo audio-mikser koji je isporučen s zvučnom karticom – C-Media Mixer. Audio-mikser
se nalazi u taskbaru kako je prikazano na slici 1. (krajnja lijeva ikona).

Slika 1.: Pokretanje programa C-Media Mixer.
C-Media Mixer je predstavljen krajnjom lijevom ikonom a pokreće se dvostrukim klikom na nju. Nakon

pokretanja otvara se jedan od prozora sa slika 2. i 3..

Nakon pokretanja C-Media Mixera otvara jedan od prozora prikazanih na slikama 2. i 3. – prvi od
njih (slika 2.) omogućuje kontrolu reprodukcije zvuka dok drugi omogućuje kontrolu snimanja (slika
3.).

Slika 2.: Izgled programa C-Media Mixer – kontrola reprodukcije.
Na krajnjem lijevom kraju prozora nalaze se gumbi označeni s VOL i REC koji omogućuju odabir izmedu
kontrola za snimanje (REC) i reporodukciju zvuka (VOL). Svaki od mogućih izvora zvuka predstavljen je
sličicom. Ukoliko je sličica osvijetljena svijetlo plavom bojom odgovarajući izvor zvuka je uključen, tj.
omogućena je reprodukcija, a u suprotnom je isključen. Dvije kontrole iznad svake sličice su glasnoća i

balans. Prva kontrola s lijeva je glavna kontrola glasnoće, dok je treća kontrola s lijeva kontrola
mikrofona.

1.1. Provjera ispravnosti mikrofona

Mikrofon se priključuje na prednju ploču računala u 3,5 mm priključak označen s IN. Nakon pri-
ključivanja mikrofona pokrenite C-Media Mixer u kojem odaberete podešavanje kontrola reprodukcije
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Slika 3.: Izgled programa C-Media Mixer – kontrola snimanja.
Na krajnjem lijevom kraju prozora nalaze se gumbi označeni s VOL i REC koji omogućuju odabir izmedu
kontrola za snimanje (REC) i reporodukciju zvuka (VOL). Svaki od mogućih izvora zvuka predstavljen je
sličicom. Ukoliko je sličica osvijetljena svijetlo plavom bojom odgovarajući izvor zvuka je uključen, tj.
omogućeno je snimanje, a u suprotnom je isključen. Dvije kontrole iznad svake sličice su glasnoća i

balans. Druga kontrola s lijeva je kontrola mikrofona.

zvuka (VOL). Potrebno je uključiti mikrofon (treća grupa s lijeva) i povećati glasnoću. Sada se mi-
krofon izravno prenosi na zvučnike računala te se normalan govor i lagano lupkanje po mikrofonu
mora čuti sa računalnih zvučnika. Moguća je i pojava mikrofonije.
Ukoliko se nǐsta ne čuje s računalnih zvučnika pokušajte mikrofon izravno spojiti u 3,5 mm priključak
roze boje koji se nalazi sa stražnje strane računala (najdonji od tri 3,5 mm priključka u nizu).

1.2. Postavljanje miksera za snimanje i reprodukciju

Nakon provjere ispravnosti mikrofona potrebno je podesiti audio-mkiser za snimanje i reprodukciju.
Pokrenite C-Media Mixer te odaberite podešavanje kontrola reprodukcije zvuka (VOL). Izgled miksera
je prikazan na slici 2.. U mikseru isključite reprodukciju s mikrofona zbog izbjegavanja pojave jeke
kod snimanja. Poželjno je isključiti i sve preostale izvore zvuka osim master i wave, što se postiže
isključivanjem svih skupina osim prve i četvrte s lijeva. Na taj način će na računalnom zvučniku biti
reproduciran isključivo zvuk iz wave izvora, što je u stvari 16-bitni D/A pretvornik koji se nalazi na
zvučnoj kartici.
Nakon što su podešene kontrole za reporodukciju zvuka potrebno je podesiti i kontrole za snimanje.
U C-Media Mixeru odaberite podešavanje kontrola snimanja zvuka (REC). Kako vršimo snimanje s
mikrofona potrebno je odabrati samo mikrofonski ulaz za snimanje, a sve ostale ulaze potrebno je
isključiti. Mikser bi sada trebao izgledati kako je prikaznao na slici 3.. Na taj način će prilikom
snimanja na ulaz u A/D pretvornik na zvučnoj kartici biti proslijeden isključivo zvuk iz mikrofona.
Zbog loše kvalitete mikrofona potrebno je povećati osjetljivost mikrofona za faktor 10, tj. za 20 dB.
U C-Media Mixeru potrebno je otvoriti advanced kontrole što se postiže odabirom ikone s ucrtanim
klještima i čekićem koja se nalazi ispod VOL i REC ikona. U novotvorenom prozoru odaberite Options
tab te u njemu označite Enable Microphone Booster kako je prikazano na slici 4..

2. Postupak snimanja govornog signala

2.1. Program za snimanje govornog signala

Snimanje govornog signala se provodi korǐstenjem programa Sound Recorder. Sve zvučne datoteke
snimljene ovim programom imati će nastavak .wav. Snimanje se provodi digitalizacijom govornog
signala primjenom A/D pretvornika na zvučnoj kartici. Digitalizirani uzorci signala pohranjuju se u
izlazoj .wav datoteci. Glavi parametri sustava za digitalizaciju su:

1. broj ulaznih kanala (mono ili stereo),

2. rezolucija A/D pretvorbe (broj bita po uzorku),

3. frekvencija otipkavanja.

Prije snimanja govornog signala nužno je potrebno podesiti ove parametre.
Program za snimanje se pokreće tako da se odabere Start → All Programs → Accessories → Entertain-
ment → Sound Recorder. Nakon pokretanja programa pojavljuje se glavni prozor koji je prikazan
na slici 5.. U donjem dijelu prozora se redom nalaze kontrole: 1. na početak, 2. na kraj, 3. započni
reprodukciju, 4. prekini reprodukciju ili snimanje i 5. započni snimanje. U sredini prozora se nalazi
osciloskopski prikaz signala na ulazu A/D pretvornika.
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Slika 4.: Napredne kontrole C-Media Mixera
U naprednim kontrolama odaberite Options tab i u njemu označite Enable Microphone Booster.

Slika 5.: Izgled programa Sound Recorder.
U donjem dijelu prozora se redom nalaze kontrole: 1. na početak, 2. na kraj, 3. započni reprodukciju, 4.
prekini reprodukciju ili snimanje i 5. započni snimanje. U sredini prozora se nalazi osciloskopski prikaz

signala na ulazu A/D pretvornika.
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2.2. Podešavanje parametara snimanja

Prije početka snimanja govornog signala potrebno je podesiti parametre snimanja. Navedeni para-
metri sustava za snimanje se podešavaju se na sljedeći način:

1. Otvorite izbornik File te odaberite stavku Properties.

Slika 6.: Izgled programa Sound Recorder.
Da bi provjerili parametre snimanja i eventualno ih promijenili odaberite stavku Properties u File

izborniku.

2. Sada se otvara prozor Properties for Sound koji je prikazan na slici 7., a u kojem su navedeni
parametri signala. Početne postavke su tipično PCM 22.050 kHz: 8 bit: Mono. Na ovom
predmetu postavke moraju biti PCM 11.025 Hz: 16 bit: Mono. Da bi promijenili parametre
signala odaberite Recording Formats u Choose from padajućem izborniku te pritisnite Convert
Now. . . gumb.

3. Nakon što ste odabrali Convert Now. . . otvara se prozor Sound Selection koji je prikazan na
slici 8.. U njemu odaberite parametre snimanja PCM u Format padajućem izborniku i 11.025
Khz: 16 bit: Mono 21 kb/sec u Attributes padajućem izborniku. Odabranu konfiguraciju je
moguće i pohraniti tako da se naknadno ne moraju ponovno definirati detaljni parametri već
je dovoljno samo odabrati željenu konfiguracija. Odabrane postavke snimite pod imenom
SPUS.

4. Potvrdite sve odabrano pritiskom na OK.

Važno: Svaki put kada odaberete File → New potrebno je provjeriti da li su parametri signala ispravni
(fs = 11025 Hz, 16 bita, mono).

2.3. Ulazna osjetljivost mikrofona

Vrlo je značajno pravilno podesiti osjetljivost mikrofona, odnosno glasnoću izgovora prilikom sni-
manja. U slučaju premale osjetljivost mikrofona ili pretihog govora biti će iskorǐsten samo mali dio
ulazne dinamike A/D pretvornika čime povećavamo kvantizacijsku pogrešku.
Primjer: Ako je nominalna ulazna dinamika signala 16-bitnog A/D pretvornika 1 V i ako to odgovara
digitalnim kodovima od −215 do 215 − 1, tada će uz ulazni napon od 0,125 V biti iskorǐstena samo
jedna osmina ukupne dinamike što znači da će se na izlazu A/D prevtornika pojavljvati samo kodovi
od −212 do 212− 1, tj. rezultat je isti kao da se radi o 13-bitnom pretvorniku. Za takav ulazni signal
će relativni odnos izmedu energije signala i energije šuma kvantizacije biti 13 ·6 dB = 78 dB umjesto
očekivanih 96 dB za slučaj potpunog iskorǐstenja ulazne dinamike.
Kvantizacijska pogreška nije jedini uzrok degradacije snimljenog signala. Drugi uzrok degradacije
su smetnje koje postoje na ulazu u A/D pretvornik, a većinom dolaze od kapacitivnih preslušavanja
izmedu zvučne kartice i drugih dijelova u PC računalu. Značajni izvor smetnji je i gradska mreža
zbog koje će se u snimljenom signalu pojaviti signal smetnje frekvencije 50 Hz, ali i svih frekvencija
koje odgovaraju njezinim cjelobrojnim vǐsekratnicima. Razina ovih smetnji je neovisna o signalu koji
dolazi s mikrofona, tako da je vrlo značajno osigurati što je moguće veći iznos korisnog signala.
Iz navedenog je vidljvo da je pogodno podesiti osjetljivost na što je moguće veću, no medutim ni to nije
u potpunosti točno. Ako bi zbog prevelike osjetljivosti (ili pak zbog prevelike glasnoće izgovora) ulazni
napon A/D prevornika premašio maksimalnu dozvoljenu ulaznu dinamiku dolazi do pojave zasičenja
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Slika 7.: Properties for Sound prozor.
Ako parametri govornog signala nisu ispravni potrebno je odabrati Recording Formats u Choose from

padajućem izborniku te pritisnuti Convert Now. . . gumb.

Slika 8.: Sound Selection prozor.
U Sound Selection prozoru odaberite ispravne parametre snimanja te ih snimite pod imenom SPUS.
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(clipping). U slučaju većeg ulaznog napona od navećeg dozvoljenog pozitivnog ulaznog napona
(npr. +1 V kojem odgovara digitalni kod 215 − 1), otipkani uzorak bit će predstavljen upravo s tim
maksimalnim pozitivnim kodom, neovisno o stvarnoj vrijednosti ulaznog napona. Analogna situacija
se javlja za negativne napone koji prelaze najveću dozvoljenu vrijednost (npr. −1 V). Takva operacija
zasičenja uzrokuje nelinearno izobličenje govornog signala (odrezivanje vrhova) koje je neželjeno i
nepovoljno prilikom analiza, a uzrokuje i čujnu degradaciju u reproduciranom govoru. Zbog toga je
prilikom snimanja potrebno osigurati da ulazni signal A/D pretvornika nikad ne premaši maksimalnu
dozvoljenu ulaznu dinamiku, tj. da ne dode do pojave odrezivanja.

2.4. Kontrola signala na ulazu A/D pretvornika prilikom snimanja

U svrhu kontrole razine signala na ulazu u A/D pretvornik moguće je koristiti dva indikatora.

Prvi se nalazi u crnom prozorćiću programa Sound Recorder (vidi sliku 5.) i ima ulogu minijaturnog
osciloskopa koji je aktivan za vrijeme snimanja. Ako valni oblik signala prilikom snimanja poprima
vrijednosti od donjeg do gornjeg ruba ovog prikaza razina signala je prevelika, a ako je osjetljivost
premala u osciloskopskom prikazu vidimo samo ravnu crtu. Ovaj osciloskopski indikator je aktivan
samo kada je snimanje pokrenuto, što se provodi pritiskom na tipku sa crvenom točkom u glavnom
prozoru Sound Recordera. Osjetljivost mikrofona se podešava regulacijom potenciometra za mikro-
fonski ulaz u mikseru za snimanje (slika 3.), a moguće ju je skokovito podignuti za 20 dB odabirom
stavke Enable Microphone Booster kako je prikazano na slici 4..
Drugi indikator je tipa VU-metra i obično se nalazi se kraj potenciometra za podešavanje osjetljivosti
mikrofonskog ulaza na mikseru za snimanje, no C-Media Mixer nema taj VU-metar. VU-metar
oponaša mjerač nivoa signala koji se sastoji od vǐse raznobojnih dioda. Što je nivo signala vǐsi pali
se sve vǐse i vǐse dioda odozdo prema gore. Najniže diode su tamno zelene boje, zatim slijede svjetlo
zelene pa onda žute dok su najvǐse diode crvene boje. U slučaju korǐstenja VU-metra osjetljivost
mikrofona treba podesiti tako da uz normalnu jačinu govra sve zelene, a ponekad i žute diode budu
upaljene. Crvene diode se ne smiju paliti. Ako je osjetljivost premala, neće se upaliti niti jedna od
dioda.

2.5. Opće preporuke za postupak snimanja

Prije samog snimanja potrebno je mikrofon usmjeriti prema ustima govornika i postaviti ga na uda-
ljenost od otprilike 10-15 cm od glave govornika kao što je prikazano na slici 9.. Za vrijeme snimanja
mikrofon mora stajati mirno na podlozi i ne treba ga držati ili tresti.
Prilikom snimanja potrebno je obratiti pažnju na položaj mikrofona u odnosu na usta govornika.
Mikrofon bi trebao biti što je moguće bliže ustima govornika tako da i uz manju podešenu osjetljivost
mikrofona postižemo dovoljni nivo signala na ulazu A/D pretvornika. Ako je pak mikrofon predaleko
od od govornika potrebno je povećati osjetljivost, no tada će mikrofon osim govora registrirati i sve
moguće neželjene akustičke i električne smetnje. Nepoželjno je da se mikrofon nalazi direktno u
struji zraka koja izlazi iz usta jer u tom slučaju mikrofon registrira i neželjene zračne udare koji se
manifestiraju kao neugodni udari u reproduciranom signalu. Zbog toga mikrofon mora biti postavljen
pod kutem u odnosu na centralnu os usta kao što je prikazano na slici 9. tako da glavna struja
zraka prode mimo njega. Jačina izgovora prilikom snimanja mora biti normala da bi registrirali što
prirodniji govorni signal.
Opisani postupak regulacije osjetljivosti mikrofona i njegovog položaja, te podešavanja pravilne jačine
izgovora potrebno je provesti vǐsestrukim ponavljanjem snimanja i reprodukcije sve dok se ne dobije
pravilna razina signala. Snimljeni signal treba biti što je moguće čǐsči i bez neželjenih smetnji (šuma,
bruma glasa drugih govornika, zvuka iz prostorije i sličnog).

2.6. Postupak reprodukcije snimljenog govornog signala

Nakon što je govor snimljen moguće ga je reproducirati pritiskom na tipku sa trokutićem (Play).
Da bi bilo moguće čuti snimljeni zvuk potrebno je provjeriti potenciometre za regulaciju razine
reprodukcije za koje je poželjno da su postavljeni negdje oko sredine. Ti se potenciometri nalaze u
mikseru za reprodukciju (slika 2.). Razina signala na izlazu D/A pretvornika prilikom reprodukcije
je takoder vidljiva na dva indikatora: na osciloskopskom prikazu u Sound Recorederu (slika 5.) i na
VU-metru koji se obično nalazi pored potenciometra za regulaciju glasnoće Wave izlaza u mikseru
za reprodukciju. Pored ovih programskih podešavanja potrebno je provjeriti i zvučnike – da li su
upaljeni (pod napajanjem), te da li je potenciometar za regulaciju glasnoće ispravno postavljen.
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Slika 9.: Pravilan položaj mikrofona prilikom snimanja.

3. Završna obrada i pohranjivanje snimljenog govora

Nakon što je uspješno snimljena željena govorna poruka i nakon što je utvrdeno da prilikom repro-
dukcije ne dolazi do pojave zasićenja možemo pohraniti snimljeni govorni signal u datoteku. Prije
pohranjivanja pogodno je iz snimljene poruke izbaciti pauze koje se nalaze na samom početku i na
samom kraju.

Da bi odredili točan vremenski trenutak početka aktivnog dijela govorne poruke polagano pomičite
scroll-bar Sound Recordera u desno dok se u osciloskopskom prikazu signala ne pojavi prva vrijednost
različita od nule. Zapamtite vremenski trenutak koji odgovara ovoj poziciji – očitajte vrijeme sa
brojača lijevo od osciloskopskog prikaza. Sada zbog provjere pokrenite reprodukciju od ove pozicije
na dalje. Ako je poruka reproducirana u cijelosti, tj. ne nedostaje početak, tada je moguće taj
početni dio poruke do nadenog vremenskog trenutka izbrisati. Brisanje se provodi tako da se pomoću
scroll-bar ponovno postavi zapamćena vremenska pozicija početka poruke. Sada se iz glavnog prozora
odabere Edit → Delete Before Current Position.

Potpuno analogna operacija se provodi i za brisanje pauze na kraju govorne poruke. Pomaknite se
na kraj poruke, te ga zatim polagano vraćajte scroll-bar u lijevo dok se u osciloskopskom prikazu ne
pojavi signal različit od nule. Na brojaču očitajte i zapamtite ovaj vremenski trenutak, te pokrenite
reprodukciju od nadenog trenutka do kraja poruke. Ako se prilikom reprodukcije čuje isključivo šum,
a ne i zadnji glas poruke, tada je ovaj trenutak pravilno odabran i taj dio poruke takoder može biti
izbrisan. Opet odaberite zapamćenu poziciju i iz glavnog prozora odabere Edit → Delete After Current
Position.

Na kraju još jednom reproducirajte cijelu poruku i uvjerite se da nije narušena, odnosno da su
uklonjene samo pauze s početka i kraja.

Snimljena poruka se pohranjuje u datoteku tako da se odabere File → Save As. Točno ime datoteke
i mjesto na koje ju je potrebno snimiti je navedeno u uputama za pojedinu vježbu.
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